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Einfache Formen zeichnen

Einfache Formen zeichnen

Diese Kapitel beschreibt, wie man einfache Formen zeichnet. Alle Formen, seien es 
einfache Linien, Rechtecke oder kompliziertere Formen, sind Objekte, wie sie übli­
cherweise in Vektorzeichenprogrammen genannt werden.

 In den folgenden Abschnitten wird gezeigt, wie die drei grundlegenden Formen 
Linie, Rechteck und Ellipse gezeichnet werden. Abbildung 1 zeigt diejenigen Schalt­
flächen auf der Symbolleiste Zeichnen, die mit den folgenden drei Abschnitten korre­
spondieren.

In früheren Versionen von OOo klappten einige Symbolleisten bei einem längeren 

Klick auf eine Schaltfläche mit einem Pfeil  aus und zeigten neue Symbolleis­
ten. In OOo 2.0 sind diese Symbolleisten nun voneinander getrennt. Andere 
Schaltflächenoptionen finden Sie jetzt, wenn Sie unter Ansicht > Symbolleisten 
die passende Symbolleiste auswählen.

Abbildung 1: Symbolleiste Zeichnen

Anmerkung Die Symbolleiste Zeichnen können Sie überall auf Ihrem Desktop plat­
zieren. 
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Eine gerade Linie zeichnen
Lassen Sie uns mit dem Zeichnen der einfachsten Form anfangen: einer geraden 

Linie. Klicken Sie auf das Liniensymbol auf der Symbolleiste Zeichnen  und plat­
zieren Sie den Mauszeiger an dem Punkt, wo Sie die Linie starten wollen.

Ziehen Sie die Maus, während Sie die Taste gedrückt halten. Lassen Sie die 
Maustaste los, wenn Sie die Linie enden lassen wollen. Ein blauer oder grüner Hand­
griff erscheint an beiden Enden der Linie und zeigt an, dass dies das gegenwärtig 
ausgewählte Objekt ist. Die Farben hängen vom Standardauswahlmodus ab, grün bei 
einer normalen Auswahl und blau, wenn Sie sich im Punktbearbeitungsmodus be­
finden (dieser Effekt ist allerdings nur gut zu sehen, wenn Sie in der Symbolleiste 
Optionen „Einfache Griffe“ und „Große Griffe“ eingeschaltet haben).

Abbildung 2: Eine gerade Linie 
zeichnen

Halten Sie die Umschalttaste beim Zeichnen der Linie gedrückt, um sie in einem 
Winkel zu zeichnen, der ein Vielfaches von 45° zur Horizontalen beträgt.

Halten Sie die Steuerungstaste (Strg bei PCs) beim Zeichnen der Linie gedrückt, um 
sie am jeweils nächsten Punkt des Rasters einrasten zu lassen. Die Dichte des 
Rasters können Sie unter Extras >Optionen >OpenOffice.org-Draw >Auflösung 
einstellen.

Halten Sie die Alt-Taste gedrückt, um die Linie symmetrisch vom Startpunkt aus (die 
Linie dehnt sich nach beiden Seiten des Startpunkts gleichmäßig aus) zu zeichnen. 
Damit zeichnen Sie Linien, bei denen Ihr Startpunkt immer die Mitte der Linie 
bleibt.

Die von Ihnen gezeichnete Linie erhält die Standardattribute (Farbe und Linienstil). 
Um die Linienattribute zu ändern, wählen Sie die Linie durch Anklicken aus, klicken 
mit der rechten Maustaste darauf und ändern die Attribute im Dialog Linie.
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Ein Rechteck zeichnen
Rechtecke zu zeichnen funktioniert genauso wie das Zeichnen gerader Linien, außer 

dass Sie dazu das Rechteckzeichen  aus der Symbolleiste Zeichnen benutzen. Die 

(imaginäre) Linie, die mit der Maus gezeichnet wird, korrespondiert mit der Diago­
nalen des Rechtecks, außerdem sehen Sie beim Aufziehen die Umrisse des zukünf­
tigen Rechtecks.

Abbildung 3: Ein Rechteck zeichnen

Halten Sie die Umschalttaste gedrückt, um ein Quadrat zu zeichnen. Halten Sie die 
Alt-Taste gedrückt, um ein Rechteck zu zeichnen, das sich aus seinem Mittelpunkt 
aufzieht.
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Ellipsen oder Kreise zeichnen

Um eine Ellipse oder einen Kreis zu zeichnen, benutzen Sie das Ellipse-Zeichen  
aus der Symbolleiste Zeichnen (ein Kreis ist einfach eine Ellipse, bei der die zwei 
Achsen dieselbe Länge haben). Die Ellipse, die gezeichnet wird, ist die größte Ellip­
se, die in das (imaginäre) Rechteck passt, das mit der Maus gezeichnet wurde.

Abbildung 4: Eine Ellipse zeichnen

Andere Formen sind jeweils als Schaltfläche in der Symbolleiste Zeichnen verfüg­
bar. In vorherigen Versionen von OOo waren diese Formen erweiterte Funktionen, 
die durch längeres Drücken der Schaltfläche Ellipse gezeigt wurden.

Es gibt drei andere Möglichkeiten eine Ellipse oder Kreis zu zeichnen:

➢ Halten Sie die Umschalttaste während des Ziehens gedrückt, um das Zeichnen 
eines Kreises zu erzwingen.

➢ Halten Sie die Alt-Taste (zusammen mit der Umschalttaste) gedrückt, um eine 
symmetrische Ellipse (einen Kreis) vom Mittelpunkt aus zu zeichnen.

➢ Halten Sie die Strg-Taste während des Zeichnens gedrückt, um die Ellipse oder 
den Kreis an den Rasterlinien einrasten zu lassen.

Anmerkung Wenn Sie zuerst die Steuerungstaste drücken (und halten), bevor Sie ir­
gendeine dieser Schaltflächen anklicken (Linie, Rechteck, Ellipse und 
Text), erscheint das gewählte Objekt direkt auf der Seite mit einer Stan­
dardgröße, -form und -farbe. All diese Attribute können danach geändert 
werden.
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Die Standard-Zeichenobjekte

In diesem Abschnitt finden Sie eine komplette Übersicht der Standardobjekte in 
Draw. Diese Objekte können bearbeitet oder kombiniert und so manipuliert werden, 
dass sie komplexere Formen bilden. Wir haben bereits gesehen, wie man einige von 
ihnen benutzt.

Aller hier beschriebenen Werkzeuge und Werkzeugpaletten sind über die Sym­
bolleiste Zeichnen zugänglich (Ansicht > Symbolleiste > Zeichnen).

Text

Benutzen Sie das Textwerkzeug  zum Texteschreiben und zur Auswahl der 
Schriftart, -farbe, -größe und anderer Attribute. Klicken Sie auf eine leere Stelle auf 
der Zeichenfläche, um den Text an dieser Stelle zu schreiben. Falls Sie auf ein 
Objekt klicken, wird der Text mittig in das Objekt geschrieben. Wenn Sie möchten, 
dass der Text innerhalb des Objekts bleibt und die Grenze des Objekts dabei zum 
Textrahmen wird, schalten Sie unter Format > Text die Option Konturfluss ein.

Wenn Sie den Text zu Ende getippt haben, klicken Sie in den Textrahmen. Drücken 
Sie die Eingabetaste, um zur nächsten Zeile zu gelangen. Durch Doppelklicken auf 
den Text können sie ihn jederzeit editieren.

Wenn Sie Text tippen, enthält die oberste Symbolleiste die üblichen Absatzattribute: 
Einzüge, erste Zeile und Tabulatoren.

Sie können das Format des Texts oder von Teilen davon ändern. Das Formatvor­
lagenfenster funktioniert auch hier (wählen Sie Format > Formatvorlagen oder 
drücken Sie F11, um es aufzurufen), sodass Sie Vorlagen erstellen können, die Sie 
genau so wiederholt in anderen Textrahmen einsetzen können, so wie Sie es auch 
mit Writer machen würden.

Textrahmen können Füllfarben, Schatten und andere Attribute wie jedes andere 
Draw-Objekt auch haben. Sie können den Rahmen drehen und den Text in jedem 
Winkel schreiben. Diese Optionen sind per Rechtsklick auf das Objekt verfügbar.

Benutzen Sie die Legenden-Werkzeuge, die in der Symbolleiste Zeichnen angesiedelt 
sind, um mit Text in unterschiedlichsten Rahmen Hinweise und Erläuterungen zu 
Bildern, Zeichnungen oder Diagrammen zu geben.
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Rechtecke und Quadrate

Die Symbolleiste hatte früher acht Werkzeuge. In OOo 2.0 befindet sich das 
Rechteck nun direkt auf der Symbolleiste Zeichnen, während die anderen 
Rechteck- und Quadrat-Werkzeuge unter der Ausklapp-Schaltfläche Standard­

formen  auf der Symbolleiste Zeichnen zu finden sind (das Objekt auf der 
Schaltfläche ist immer das zuletzt benutzte).

Kreise, Ellipsen und Sektoren

Die Symbolleiste hatte früher 14 Werkzeuge. In OOo 2.0 befindet sich die Ellip­
se nun direkt auf der Symbolleiste Zeichnen. Die anderen Kreise, Ellipsen und 

Sektoren finden sich unter der Ausklapp-Schaltfläche Standardformen  auf 
der Symbolleiste Zeichnen.

3D-Objekte
Die Palette der 3D-Objekte (Abbildung 5) enthält 8 Grundformen, die dazu benutzt 
werden können, durch Verschmelzung oder Kombination komplexere dreidimensio­
nale Objekte zu  bilden. 

In OOo 2.0 gehört die Palette der 3D-Objekte zu der Symbolleiste Zeichnen. Dort 
ist sie allerdings nicht standardmäßig sichtbar. Um sie auf der Symbolleiste 
Zeichnen sichtbar zu machen, 

klicken Sie auf die schattierte Fläche mit dem Pfeil am Ende der Sym­

bolleiste   und wählen Sie Sichtbare Schaltflächen > 3D-Objekte.

Damit wird die Schaltfläche 3D-Objekte auf der Symbolleiste 
Zeichnen sichtbar.

Abbildung 5: Palette der 3D-Objekte

Alle 3D-Objekte werden in gleicher Weise gezeichnet: Klicken Sie die Schaltfläche 
mit dem  gewünschten 3D-Objekt an und ziehen Sie auf der Arbeitsfläche mit der 
Maus ein Rechteck auf. Sie sehen beim Aufziehen einen Rahmen (Abbildung 6), in 
dem sich das Objekt befinden wird. 
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Abbildung 6: 3D-Rahmen

Auf 3D-Objekte können in Draw vielfältige 3D-Effekte angewendet werden 
(Rechtsklick auf das Objekt und Wählen von 3D-Effekte im PopUp-Menü). Damit be­
arbeiten Sie Geometrie,  Schattierung, Textur, Farbe, Material und Beleuchtung des 
Objekts. Im Kapitel „3D-Objekte und Bitmaps bearbeiten” finden Sie dazu ausführli­
che Beschreibungen.

Kurven
In der Palette Kurve (Abbildung 7) finden Sie 8 Werkzeuge, um unregelmäßige 
Formen zu zeichnen.

In OOo 2.02 befindet sich die Palette Kurve auf der Symbolleiste Zeichnen. Beim 
darüberfahren mit der Maus zeigt Ihnen OOo 2.0 als Tooltip „Kurve“ an. Wenn 
Sie diese Palette abreißen, zeigt Ihnen die Titelleiste der Palette jedoch den 
Namen „Linien“, wie in Abbildung 7 zu sehen. Dies ist etwas widersprüchlich, 
wird aber bei der nächsten Version schon berichtigt sein.

Abbildung 7: Palette Kurve 
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Linien und Pfeile
Auf der Palette Pfeile (Abbildung 8) finden Sie 10 Werkzeuge, um Linien zu zeich­
nen. Dabei sind diverse Pfeilformen und -enden möglich.

In OOo 2.0 befindet sich die Palette Pfeile auf der Symbolleiste Zeichnen. Ist sie 
dort nicht sichtbar, können Sie folgendermaßen sichtbar machen:

Klicken Sie auf die schattierte Fläche mit dem Pfeil am Ende der Symbolleiste  

und wählen Sie Sichtbare Schaltflächen >Linien und Pfeile.

 Dasselbe erreichen Sie über Ansicht > Symbolleisten > Linien und Pfeile

Abbildung 8: Palette Pfeile

Verbinder
Verbinder  sind Linien oder Pfeile, deren Enden an so genannten „Klebepunkten“ an 
Zeichenobjekten festsitzen. Wenn man ein solches Objekt bewegt, wandert der Ver­
binder mit.

Verbinder sind besonders nützlich, um etwa Organigramme, Flussdiagramme und 
Mindmaps anzufertigen. Beim Verschieben und Neuanordnen von Diagrammblöcken 
bleiben die Verbindungen jederzeit erhalten.  

Sie finden in Draw eine ganze Reihe moderner Verbinder und Verbinderfunktionen.

Verbinder zeichnen - Grundlagen
Alle Objekte haben unsichtbare, mit ihnen verknüpfte Klebepunkte. Verbinder ver­
binden sich automatisch mit diesen Klebepunkten eines Objekts. Die Anzahl an Ver­
bindern pro Objekt ist von Draw standardmäßig auf 4 festgesetzt. Später werden wir 
sehen, wie man die Position von Klebepunkten verändern und neue Klebepunkte hin­
zufügen kann.

Die standardmäßigen Klebepunkte befinden sich an den Mittelpunkten der Seiten 
des Rechtecks, das das Objekt umgibt, wie in Abbildung 9 zu sehen ist. 
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Abbildung 9: 4 Klebepunkte

Bewegt man ein Ende eines Verbinders über ein Objekt, werden dessen Klebepunkte 
sichtbar und Sie können das Ende des Verbinders einfach auf einem davon 
„ablegen“, siehe Abbildung 10. Später wird dieses Ende des Verbinders auch bei 
Verschieben des Objekts oder des Verbinders selber immer mit diesem Klebepunkt 
verbunden bleiben.

Anmerkung

Klebepunkte sind nicht dasselbe wie die kleinen blauen oder grünen 
„Griffe“ eines Objekts. Benutzen Sie die Griffe, um Objekte zu bewegen oder 
ihre Größe zu verändern, benutzen Sie die Klebepunkte dagegen, um Ver­
binder an ein Objekt zu „kleben“.

Abbildung 10: Einen Verbinder „ankleben“

Sie können den Anfang oder das Ende eines Verbinders auch mitten auf ein Objekt 
setzen. In einem solchen Fall sucht sich OOo Draw beim Verschieben oder 
Verändern des Objekts selber den optimalen Klebepunkt, um die Länge des Ver­
binders zu minimieren.

Wie alle anderen Objekte haben auch Verbinder einen oder mehrere Kontrollpunkte, 
die das Zeichnen erheblich vereinfachen. Sie können mit deren Hilfe ihre Form und 
ihre Proportionen verändern, siehe Abbildung 11. 
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Abbildung 11: Kontrollpunkte eines Ver­
binders

OOo vermeidet es, wenn irgend möglich, einen Verbinder über ein Objekt zu zeich­
nen.

Sie können die Verbindung zwischen einem Verbinder und einem Objekt jederzeit 
aufbrechen, indem Sie das Ende des Verbinders vom Klebepunkt des Objekts wegzie­
hen. Ziehen Sie beide Enden des Verbinders von den Objekten weg, wird er zu einem 
normalen Linien- oder Kurvenobjekt, was Sie daran erkennen können, dass die Kon­
trollpunkte blau sind und nicht rot wie bei einem Verbinder.

Die Symbolleiste Verbinder

In OOo 2.0 ist die Symbolleiste Verbinder Teil der Symbolleiste Zeichnen. 

Die Symbolleiste Verbinder (Abbildung 12) enthält eine große Anzahl an Schaltflä­
chen. 

Verbinder können in vier Gruppen eingeteilt werden:

• Traditionelle Verbinder, so wie Sie sie bisher kennen.
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• Linien-Verbinder bestehen aus einem Liniensegment und zwei kleineren Seg­
menten an den waagerechten und senkrechten Enden.

• Direkt-Verbinder bestehen aus einer einzigen einfachen Linie.

• Kurven-Verbinder basieren auf Bezierkurven (Bezierkurven werden in einem 
anderen Kapitel besprochen).

Klebepunkte editieren

Die Behandlung der Klebepunkte gehört vielleicht nicht unbedingt in dieses einfüh­
rende Kapitel. Wenn Sie momentan nicht mit Verbindern arbeiten, können Sie diesen 
Abschnitt beruhigt auslassen.

Klebepunkte können über eine besondere Symbolleiste bearbeitet werden. Sie ist 
nicht standardmäßig sichtbar und wird über Ansicht > Symbolleisten > Klebe­
punkte zum Vorschein gebracht. 

Um Klebepunkte bearbeiten zu können, muss außerdem in der Symbolleiste Zeich­

nen die Schaltfläche Klebepunkte aktiviert sein. 

Das erreichen Sie durch Anklicken dieser Schaltfläche oder über Bearbeiten > 
Klebepunkte.

Im Folgenden wird kurz beschrieben, wie die einzelnen Schaltflächen funktionieren.

Mit dieser Schaltfläche fügen Sie einen neuen Klebepunkt ein.
Zeichnen Sie ein neues Objekt. Wenn das Objekt gefüllt ist, kann der 
Klebepunkt auch irgendwo ins Innere des Objekts gesetzt werden, nicht 
nur an seinen Rand. Aktivieren Sie die Schaltfläche Klebepunkte auf der 
Symbolleiste Zeichnen wie oben beschrieben.

Die Klebepunkte bleiben so lange sichtbar, wie die Schaltfläche Klebe­
punkte aktiv ist. Sie erscheinen als kleine blaue Kreuze und ein angewähl­
ter Klebepunkt ist grau unterlegt. Sie können die Klebepunkte mit der 
Maus verschieben und mit der Entfernen-Taste löschen.

Einfache Formen zeichnen in Draw 11



Die Standard-Zeichenobjekte

Mit diesen vier Schaltflächen wählen Sie die Austrittsrichtungen, die für einen 
Klebepunkt erlaubt sind. Sie können für einen ausgewählten Klebepunkt meh­
rere dieser Schaltflächen auswählen. Sie spezifizieren damit, aus welcher 
Richtung / welchen Richtungen ein Verbinder am Klebepunkt ankommen darf.

Wenn Sie beispielsweise die Schaltfläche  aktivieren, wird jeder Ver­
binder gezwungenermaßen von links zu diesem Klebepunkt kommen. 
In der folgenden linken Zeichnung sehen Sie einen Klebepunkt mit Aus­
trittsrichtung links in einem Kreis und einen Klebepunkt mit Austrittsrich­
tung rechts in einem Quadrat. In der rechten Zeichnung sehen Sie die Aus­
wirkung auf einen Verbinder.

Wenn Sie sich im Klebepunkt-Bearbeitungsmodus befinden und Sie fügen eine 
andere Austrittsrichtung hinzu, wie zum Beispiel durch Aktivieren der Schalt­
fläche  , ermöglichen Sie OOo, den Verbinder im Zweifelsfall zu kürzen. Für 
das obige Beispiel würde das Einfügen der Austrittsrichtung unten in dem 
Kreis zu folgendem Ergebnis führen:

Wenn diese Schaltfläche („Klebepunktposition relativ“) aktiv ist (das ist sie 
standardmäßig), verschiebt sich der Klebepunkt bei einer Größenver­
änderung eines Objekts relativ mit, wie im folgenden Beispiel zu sehen:
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Wenn diese Schaltfläche deaktiviert wird, werden die restlichen Schaltflä­
chen der Symbolleiste, die vorher ausgegraut waren, anwählbar. Mit 
diesen Schaltflächen können Sie bestimmen, wie Klebepunkte bei einer 
Größenveränderung des Objekts platziert werden.

Mit diesen drei Schaltflächen bestimmen Sie die horizontale Position des 
Klebepunkts. Sie können dabei wählen, ob die Position links-, rechtsbündig 
oder zentriert im Verhältnis zur ursprünglichen Position bleibt. Zur Ver­
anschaulichung sehen Sie im folgenden Beispiel einen Klebepunkt, der ho­
rizontal linksbündig ist. Der Abstand des Klebepunktes zum linken Rand 
bleibt immer gleich (außer, wenn der Abstand geringer wird als die Breite 
des Objekts).

Mit diesen drei Schaltflächen bestimmen Sie die vertikale Position des 
Klebepunkts. Sie können dabei wählen, ob die Position oben, unten oder 
zentriert im Verhältnis zur ursprünglichen Position bleibt.
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